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Visit the SKED 3.1 Web Page 
 
For the latest SKED 3.1 updates, frequently asked 
questions and solutions, visit the SKED 3.1 website 
by selecting SKED Updates on WEB URL:  
https://secure.nslc.navy.mil/pms/pms.nsf .  

........................................ (3-07) 

Applying FR Updates to 
SKED 3.1 
With the various on going NAVSEA and 
COMNAVSURFOR processes, converting MIP 
SYSCOM numbers from conventional numbers to 
RCM (ESWBS) numbering and standardizing 3M 
Workcenters aboard Naval Surface Force Ships, this 
sequential process is recommended when applying the 
Force Revision to SKED 3.1.  This will reduce the 
deleting of EGLs, and manually building new work 
centers or adding MIPs. 
 
1.  Ships 3MC after receiving the NAVY PMS 

CD-ROM for the new FR, run the MIP Changer 
 utility.  

a.    On the server hosting SKED 3.1, browse to 
the Navy PMS CD-ROM >SKED Update 
Utilities> SKED 31MIPConverter.exe 

b.    Execute SKED31MIPConverter.exe.  A  
report will be issued listing all that has been  
changed by work center. 

 
2. Commands needing to rename or split work 

centers to align with Standardized Work center, 
run the SKED 3.1 Work center Manipulation 
Utility. 
a.    Print the operating instructions by browsing 

to the Navy PMS CD-ROM >SKED Update 
Utilities>SKED31WorkcenterManipulation 
Utility.txt.  

b.    Browse to the NAVY PMS CD-ROM 
>SKED Update Utilities>skedwcchg.exe. 

c.    Execute skedwcchg.exe using the 
SKEDADMIN login and password.  Follow 
the wizard to perform changes.  

 
3.   Update the FR PMS Data into SKED 3.1. 
       Note:  Depending on system hardware, this 

process may take several hours to complete.  
a.    On the server hosting SKED 3.1, log SKED 

3.1 as an Administrator or 3MC user. 
b.    From the menu bar, select Admin>Update 

Data>Update PMS Data and follow the 
wizard instructions. 

c.    When the Update PMS Data dialog box states 
“Update Complete!” click Exit. 

 
For SKED technical assistance, contact one of the 
following: 
 

PAC Activities:  Code 05316, Commercial (619) 556-
0577, DSN 526-0577 or e-mail 
hilario.gabrintina@navy.mil  
 
LANT Activities:  Code 05315, Commercial (757) 
967-3414, DSN 387-3414 or e-mail 
percy.saunders@navy.mil   
 
COMSUBPAC Activities:  Commercial (808) 473-
1144 or e-mail steven.a.campbell@navy.mil 
 
COMSUBLANT Activities:  Commercial (860) 694-
5333 or e-mail jeffrey.a.baur@navy.mil  
....................................... (3-07) 

SKED 3.1 Databases are 
Your Command’s PMS Life’s 
Blood 
Last Quarter several NIAPS servers had failures that 
required the servers to be rebuilt.  Three of the 
affected commands did not have external backup 
copies of their SKED31, and SKED31Archive 
databases.  Their only option was to rebuild their 
SKED 3.1 schedules from scratch.  It is highly 
recommended that you ensure you have a copy of the 
SKED31.bak and SKED31Archive.bak stored on a 
source external of the NIAPS Server.  
 
For those commands that run SKED 3.1 in Network or 
Desktop mode, you need to have an external copy of 
SKED3DB.DAT, SKED31crewslist.dat, the 
Workcenter folder and its sub directories stored in a 
location other than the NMCI Network, or the Drive 
that is hosting your SKED 3.1 data.  
....................................... (2-08) 
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SKED 3.2 Development 
SKED 3.2 has completed its development phase and is 
currently going through the various certification 
requirements.  SKED 3.2 will initially be installed on 
selected commands in the Norfolk area as soon as the 
certification processes have been completed. 
 
SKED 3.2 installation process will include the 
conversion of existing SKED 3.1 data, training for the 
3M Coordinator, Officers, Chiefs, and Workcenter 
Supervisors.  NAVSEA installation technicians will 
be aboard for several days performing the conversion 
and training. 

........................................ (1-08) 

SKED 3.2 Integrates Fleet’s 
Requested Enhancements 
Component Based MRC Line Outs and 
Customization:  SKED 3.2 will schedule PMS at the 
component/equipment level and will be tied to 
configuration.  SKED 3.2 will allow the Workcenter 
Supervisor to customize an MRC for a specific piece 
of equipment by performing a line-out on steps, as 
allowed by NAVSEAINST 4790.8B, that are not 
applicable for that equipment or configuration.  The 
supervisor may also add custom notes for the Tools, 
Parts, and Materials block.  In addition, the 
component’s name, location, and serial number will 
be displayed on the MRC.  If the card is destroyed, 
simply print its replacement, removing the need to 
review and approve the MRC. 
 
Increased Automation / Workflow:  SKED 3.2 
includes automated workflow mechanisms that 

provide customized task lists for each user.  When a 
user logs into SKED 3.2, the user’s task list will be the 
welcome screen.  This is a customized list of actions 
that require the user’s attention and automatically 
links the user to other areas of the program where 
those tasks need to be performed.  Assigned 
maintenance tasks, feedback report approvals, PMS 
alerts for out-of-periodicity maintenance, assigned 
training tasks, and spot check assignments are 
examples of the types of tasks that are available from 
the user’s task screen.  
 
Increased Support for Situational Maintenance:  
The standardization of situational maintenance 
requirements has allowed SKED 3.2 to automatically 
build and associate “global” (ship-wide) and “local” 
(equipment specific) events.  These events are 
automatically built and updated when the Force 
Revision data is updated into SKED.  The application 
will also present to each work center supervisor, a 
concise list of situations that their PMS identifies.  
SKED 3.2 supports “states”, “triggers”, and counter-
based situations. 
 
Increased Performance and Reliability:  SKED 3.2 
performs real-time updates to the database for 
increased performance, reliability, and accuracy.  
Therefore, ship-wide reports are always based on 
current information.  These updates also provide the 
ability for multiple users to accurately access work 
center data at the same time.  Extensive data 
validation routines ensure that only the proper 
information may be entered into the system, and the 
user-based roles and permissions scheme streamline 

the user-interface to reduce the amount of clutter 
presented to the user.   
 
Ship-Wide LOEP Management:  The ship-wide 
LOEP management screen provides the 3M 
Coordinator, Department Heads, and Division 
Officers the ability to electronically compare each 
work center’s LOEP with their PMS schedules.  This 
tool also allows the 3MC to see each of the ship’s 
Maintenance Index Pages (MIP) at the ship-wide level 
to ensure that all maintenance is covered. 
....................................... (4-07) 

 
How do I request Technical 
Support for SKED 3.1 and 
PMS Viewer 
To request technical support for either SKED 3.1 or 
PMS Viewer, submit your request to the NAVSEA 
Anchor Desk using one of four methods. 
 
1. Phone:  1-877-418-6824 
2. E-mail:  Help@AnchorDesk.Navy.Mil, or 

Help@AnchorDesk.Navy.Smil.Mil 
3. Naval Message using the PLAD:  

ANCHORDESK NORFOLK VA 
4. WEB Request Form: 

http://www.anchordesk.navy.mil/fleetsupport/req
uest.nsf/request 

....................................... (3-07) 
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Restarting Cycle Schedules 
Using SKED 3.1  
As directed by OPNAV and TYCOM instructions, 
periodically you are required to reset the Schedule 
Quarter after Overhaul to 1.  You can print a copy of 
the procedure to reset your Cycle Schedule from WEB 
URL www.nslc.navsea.navy.mil/pms/pms.nsf and 
selecting SKED Updates from the Download Files 
section.  Browse to the Frequently Asked Questions 
(FAQ) section, highlight the topic of interest and click 
on print. 

........................................ (2-05) 

SKED 3.1 POD Information 
Nuggets 
The SKED Master tutorial available on the FR 2-08 
PMS CD-ROM is an excellent training tool for all 
SKED 3.1 users, both officers and enlisted, and may 
be installed on their individual work stations or on 
the LAN.  Here are brief statements about SKED 
version 3.1 that can be added to the commands Plan of 
the Day or Plan of the Week.  These notes are 
intended to provide greater visibility to the numerous 
features and functions designed to help manage and 
maintain your PMS Schedules.  NAVSEA 04RM 
recommends that you periodically add one of these 
bullets to the POD. 
 

 Applying a revision – Selecting Centralized 
Data Source when applying an Admin, ACN, 
DIT, FBR, or FR quickens this process by 
highlighting which MIPs and MRCs have been 
Changed, Added or Deleted.   

 Forecasting Report – This report forecasts the 
maintenance materials required for a work center 
over a given period of time.  The report will 
display all the test equipment, materials, parts and 
miscellaneous items required to accomplish the 
scheduled PMS.  Additionally, it provides all of 
the SPMIG data associated to each item. 

 SKED Doctor – You need to run SKED Doctor 
on your work center schedule before starting a 
revision, after reordering rows, receiving 
numerous run time errors, making major changes 
to the schedule, or whenever you feel the 
schedule is suspect. 

 Saving Your Workcenter – Save your work center 
often, this will reduce the amount of data lost if 
there is a LAN hardware or software failure. 

 Backing Up Workcenter Data – Backup your 
work center in two places each week, one using 
the space provided in the SKED 3.1 Backup 
function, and a second copy to electronic media 
external of SKED 3.1, ISNS, or Servers. 

 Backup Ships 3M Data – 3MCs insure that the 
SKED 3.1 databases are being backed up daily 
and stored on the ATIS / NIAPS RAID drive, and 
is part of the ISNS daily backup.  Recommend 
that you copy them to a CD-ROM weekly to aid 
in disaster recovery of SKED 3.1.    

 Why Add My E-Mail Address – Adding your e-
mail address to your User Information allows the 
NSLCs response, (to your SKED 3.1 developed, 
submitted and transmitted TFBRs), to be e-mailed 
directly to you and the Ships 3MC. 

 Why Use 3MC E-Mail Aliases – In FBR 
Manager, Ships Information section, the e-mail 
address should be the Ships 3MC alias e-mail 

address.  The 3MC alias is used by NSLC to 
return TFBR responses electronically to the Ships 
3MC and originator.  

....................................... (4-07)  

Contacting the Originator of 
a TFBR 
On occasion, the ISEA or Commodity Specialist 
requires additional information to answer your TFBR.  
SKED 3.1 provides one method of providing them a 
portion of your contact information.  This contact is 
the e-mail address you entered into your SKED 3.1 
User information.  
 
By adding your e-mail address to the Information tab 
of the menu selection (Admin/User/Change Your 
Information), your e-mail address is automatically 
added to the TFBR that is e-mailed to the NAVSEA 
TFBR database for processing.  
 
This feature only works properly if you are logged 
into SKED 3.1 using your user name, and you submit 
a TFBR to your chain of command for approval. 
 
The speed that your TFBR is responded to could be 
directly related to the addition of your e-mail 
information into your SKED 3.1 user profile. 
....................................... (4-06) 

Opening the SKED HELP 
FILE 
The SKED 3.1 Help file can not be viewed when 
logged into SKED 3.1 due to a Security Hotfix 
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distributed by Microsoft several years back preventing 
.chm files from being opened across a network. 
 
Copying SKED help manual to your desktop: 
 
1) Copy file "SKED_3.CHM" from the NIAPS server 
SKED 3.1 directory.  
2) Paste it to your Desktop. 
3) Open the SKED help folder on your desktop to 
view help manual. 
 
If the SKED help manual does not open from your 
desktop, perform the following steps: 
 
1) Copy file "SKED_3.CHM" from the NIAPS server 
SKED 3.1 directory.  
2) Paste it to a folder, normally your temp folder, on 
the C drive of the local work station. 
3) Open the SKED help from the folder on your C 
drive to view help manual. 
    
This procedure will have to be performed at each 
work station that will need to access the SKED help 
manual. 

........................................ (4-07) 

SKED Training 
ATGLANT 3M Team is offering a one-day SKED 
Limited Team Training (LTT).  The LTT is a hands-
on workshop that will cover the creation of new work 
centers and installing Force Revisions.  For more 
information, ATGLANT point of contact is:  
 
Gary Hudson at DSN 564-9612, Commercial 
(757) 444-9612 or e-mail 

gary.w.hudson.ctr@navy.mil 
........................................ (3-05) 

 

 
 
PMS WEB Site 
The PMS Program Support webpage is available on 
the NAVAL SEA LOGISTICS CENTER (NSLC) 
home page product list.  The URL is 
www.nslc.navsea.navy.mil and the URL for the PMS 
page is https://secure.nslc.navy.mil/pms/pms.nsf. 
 
This web site provides information pertaining to PMS 
programs and services. 
 
The site provides three areas for information and a 
PMS Comment form for customer feedback.  
 
Information - Provides detailed information 
concerning PMS. 
 
Request for Services - Provides three forms available 
to the user for electronic submission.  They are: 
 
1. SPMIG Submit Forms – Used for submission of 

requests for new SPMIG numbers.   
 

 
2. On-line Text Database Account Request Forms - 

Used to request access to the PMS database. 
3. PMS Activity Address Change Form - Used to 

submit address changes. 
 
To submit these forms, simply click on the applicable 
form, add the requested information, submit, and we 
will process the information as soon as it arrives. 
   
Download Files - Provides the user access to 
download the New PMS Editor (NPE).  SKED 
updates are available for download via a link to the 
Antech Systems Inc. website.  We highly recommend 
users access the site monthly after the 10th, when the 
latest NPE and other information programs are 
updated. 
  
Points Of Contact - Provides a current listing of 
Points of Contact for the PMS Program at 
NAVSEALOGCEN Detachments Norfolk and San 
Diego.  There is also a link to a PMS Customer 
Comments form. 
 
E-mail can be sent directly from the site.  For further 
information, contact NSLC DET San Diego at (619) 
556-0723, DSN 526-0723 or NSLC DET Norfolk at 
(757) 967-3405, DSN 387-3405.    
....................................... (4-07) 
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"Small Boats” Configured 
with Cummins Q-Series 
Engines 
1.  MIPs 5833/047, 5833/309 and 5833/317 have a 
new MRC (9VKC, R-1) that provides a procedure for 
Adding Fuel Lubricity Conditioner to the Fuel 
Systems for Cummins Q-series engines utilizing JP-5 
Fuel.  
 
2.  All commands who own/operate small boats that 
are configured with Cummins Q-series engines should 
read and disseminate message 071640Z AUG 07 
NAVSURFWARCEN DET NORFOLK VA (SMALL 
CRAFT ENGINE SAFETY ADVISORY).  This 
message discusses fuel system issues associated with 
the operation of Cummins Q-series engines.  This 
advisory is also available on the PMS CD-ROM in the 
documents folder. 

........................................ (2-08) 

Submitting “Small Boat” 
Technical Feedback Reports 
(TFBRs) 
TFBRs pertaining to Small Boats are being returned to 
originator unresolved due to a Lack of Adequate 
Technical Description (LATD).  To prevent TFBRs 
being returned, the In-Service Engineering Agent 
(ISEA) at NAVSURFWARCENDET NORVA 236 
requests that small boat related TFBRs contain the 
following additional information to ensure the 
originator receives prompt and accurate resolution. 

 
1. APL (Indicate within APL/CID/AN NO/MK 

MOD section of TFBR e.g., 72A020013). 
 
2. Boat Hull Registry number (Indicate within 

remarks section of TFBR, e.g., 7MRB0213). 
 
3. Equipment serial number, make, model, type of 

system, subsystem for which the TFBR refers 
(Indicate within remarks section of TFBR). 

 
The ISEA recommends that commands validate 
assigned small boat assets against the Craft and Boat 
Support System (CBSS) website to ensure that correct 
craft are assigned: 
https://www.boats.dt.navy.mil/cbss21/. 

........................................ (2-08) 

ICMP Migration to MIP 
The process to migrate the Integrated Class 
Maintenance Plan (ICMP) task assessment procedure 
MRCs, formerly on 800 series MIPs, onto the system 
O-Level MIP is ongoing.  The Integrated Class 
Maintenance Plan affects the Surface ship community 
only.  The new ICMP section on the O-Level MIP will 
reflect as the last section of the MIP and lists unique 
ICMP maintenance requirements with periodicity 
codes of AP, such as AP-1, AP-2, etc.  AP MRC 
frequencies for accomplishment are contained within 
the ICMP, which will automatically schedule the AP 
MRC as a “Push” task (4790/2K) to the CSMP Shore 
File, normally for Regional Maintenance Center 
accomplishment. 
 
 

 
MRCs with AP periodicity are NOT to be added to the 
work center PMS schedules.  For MIPs with ICMP  
 
migration, the last 2 items of the MIP Scheduling Aids 
block will list: 
 
1.  Integrated Class Maintenance Plan (ICMP) tasks in 
the ICMP section of this document are maintenance 
tasks that are provided to assist the port engineer or 
maintenance manager with the planning and 
accomplishment of the ICMP requirement during a 
CMAV or depot level availability.  The ICMP is used 
to schedule and generate an OPNAV 4790/2K for 
accomplishment of the Maintenance Requirement. 
 
2.  The ICMP section of this Maintenance Index Page 
is intended for use by off-ship Material Condition 
Assessment Teams.  Ship's force shall not use the 
ICMP section of this Maintenance Index Page for 
scheduling Planned Maintenance Requirements for 
ship's force accomplishment. 
 
The 2006 AP-MER process evaluated the 800 Series 
MIPs and MRCs and eliminated the 800 series 
duplicates of existing O-level MRCs and retained any 
Unique Assessment MRCs to be placed on the 
appropriate O-Level MIP in the ICMP section.  
Although the ICMP is unique to the surface 
community, Carrier and Submarine program Class 
Maintenance Plans (CMP) may use ICMP Assessment 
MRCs on any shared MIP if desired by their 
respective CMP management organizations.  
....................................... (2-08) 
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AN/URN-31 Automatic 
Identification System (AIS) 
AN/URN-31 Automatic Identification System (AIS) 
will be installed on all Navy surface ships.  The 
system is Commercial Off-The-Shelf (COTS) 
equipment, designed to enhance collision avoidance.  
Mandatory Coast Guard requirements pertaining to 
system function and self testing, yield scheduled 
maintenance tasks to GPS antenna and VHF antenna 
inspection only.  MIP 4232/012 is loaded on all 
surface ship LOEPs (less PCs).  Please verify if this 
MIP is placed in correct work center, and if not, 
submit TFBR requesting work center change.  
Installation is on going; if AIS is not presently 
installed, an installation date can be determined by 
contacting In-Service Engineering Agent (ISEA), Mr. 
Jim Rook, AIS ISEA Program Engineer, 
SPAWARSYSCEN Charleston, SC, DSN 588-4532, 
Commercial (843) 218-4532. 
 
For further information, please contact: 
 
Chris Christensen, Code 4131M, DSN 387-3433, 
Commercial (757) 967-3433 or e-mail 
christopher.p.christ.ctr@navy.mil.   
 
Allen Wallace, Code 4131F, DSN 387-3408, 
Commercial (757) 967-3408, or e-mail 
allen.c.wallace@navy.mil. 

........................................ (1-08) 

 
Classified Maintenance 
Requirement Card (MRC) 
Request for Replacement 
Copy 
In FR 1-08 we included a new force revision report 
Classified MRCs to MIPs.  This report is a tool to 
validate maintenance documentation on hand is the 
latest version.  If a classified document is damaged 
beyond use or you have not received your updated 
documentation, submit a PMS feedback report 
requesting a copy of that MRC.  Ensure you include 
the MRC SYSCOM Control number and your 
justification for the replacement copy on the feedback 
report. 
 
For further assistance, please contact one of the 
following: 
 
PAC Activities:  Faye Evans, Commercial (619) 556-
0624, DSN 526-0624 or e-mail 
maureen.f.evans@navy.mil 
 
LANT Activities: Allen C. Wallace, Commercial 
(757) 967-3408, DSN 387-3408 or e-mail 
allen.c.wallace@navy.mil 

........................................ (2-08) 

 
Statements of Relevance on 
Maintenance Requirements 
Cards (MRC) 
Since 2000, Statements of Relevance (SOR) have 
been added to MRCs in an effort to provide a brief 
explanation of the purpose of the maintenance tasks.  
We have determined, based on feedback from our  
customers, that the desired benefit of these statements 
has not been realized.  As a result, we have 
reevaluated the decision to include the SOR and 
determined that the effectiveness of the SOR did not 
merit continuing this process.  Beginning with Force 
Revision 2-08, SORs will be removed as MRCs are 
updated. 
....................................... (1-08) 

Collaborative Maintenance 
Collaborative Maintenance events occur when a 
Maintenance Requirement has a Mandatory Related or 
Convenience Related Maintenance Requirement 
bound to it that requires another work center to 
perform that related maintenance.  In these situations, 
the primary work center schedules the maintenance 
and shall notify the Work Center Supervisor of the 
work center who can perform the related maintenance 
that their resources are required.  The Work Center 
Supervisors will collaboratively plan the required 
maintenance and may adjust schedules based upon 
individual workload. 
....................................... (4-07) 
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COMMANDER, NAVAL 
SUBMARINE FORCES       
3M Support Representatives 
Commander, Naval Submarine Forces has positioned 
a 3M Representative at strategic locations to provide 
quick and personal response to SUBFORCE activities 
3M issues.  The names and contact information are 
provided.  COMNAVSUBFOR requests that these 
representatives be your first point of contact to resolve 
Planned Maintenance System and other 3M related 
problems and concerns. 
 
Jeff Baur 
TYCOM 3M Representative Northeast 
Phone: (860) 694-5333 
Cell: (860) 625-3226 
Fax: (860) 694-2674 
jeffrey.a.baur@navy.mil 
 
Craig Houck 
TYCOM 3M Representative Mid-Atlantic 
Phone: (757) 967-6184 
Cell: (757) 435-2929 
Fax: (757) 967-6924 
craig.r.houck@navy.mil 
 
Felix Ruiz 
TYCOM 3M Representative Southeast 
Phone: (912) 573-9676 
Cell: (912) 577-1639 
Fax: (912) 573-4777 
felix.ruiz.ctr@navy.mil 
 
 

John Huntwork 
TYCOM 3M Rep  PACNORWEST 
Phone: (360) 315-1430 
Cell: (360) 509-8065 
Fax: (360) 396-6234 
john.huntwork@navy.mil 
 
Larry Hamon 
TYCOM 3M Rep  PACNORWEST 
Phone:  (360) 396-6780 
Cell:  (360) 204-6799 
Fax:  (360) 396-6234 
larry.hamon@navy.mil 
 
Steven “Soupy” Campbell 
TYCOM 3M Rep  Pearl Harbor 
Phone: (808) 473-1144 
Cell: (808) 728-2838 
steven.a.campbell@navy.mi1 (unclass) 
steven.a.campbell@navy.smil.mil (class)  
 
Patrick Millard 
TYCOM 3M Rep  San Diego 
Phone: (619) 553-8737 
Cell: (619) 889-7805 
patrick.millard@navy.mil 
 
Rick Gaskill 
TYCOM 3M Rep  Guam 
Phone: (671) 339-2182 
Cell: (671) 777-0224 
gaskill.gerald@css15.navy.mil 
 
 
 

William “Bill” Fortier 
CSP 3M/MRMS Coordinator 
Phone: (808) 473-4819 
Cell: (808) 391-6871 
Fax: (808) 473-4897 
william.fortier@navy.mil (unclass) 
william.fortier@navy.smil.mil (class) 
 
Michael Norman 
COMSUBPAC 3M/Calibration Coordinator 
Phone: (808) 473-0050 
Cell: (808) 371-9754 
michael.p.norman@navy.mil (unclass) 
michael.norman@navy.smil.mil  (class) 
 
James Peters 
COMSUBPAC METCAL Manager  Guam 
Phone: (671) 343-1201 
Cell: (671) 688-4174 
petersj@css15.navy.mil  (unclass) 
petersj@css15.navy.smil.mil  (class) 
 
Cranstin McFay 
SUBPAC Calibration Office  San Diego 
Phone: (619) 553-7807 
Fax: (619) 553-7810 
cranstin.mcfay@navy.mil 
 
Willy Olmo 
COMSUBFOR 3M Programs Manager 
Phone:  (757) 836-1390 
DSN:  836-1390 
FAX:  (757) 836-1271 
willy.olmo@navy.mil  (unclass) 
willy.olmo@navy.smil.mil  (class) 
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MMCM (SS) Henry Schwind 
COMSUBFOR 3M Coordinator 
Phone: (757) 836-1278 
DSN:  836-1278 
FAX:  (757) 836-1271 
henry.schwind@navy.mil  (unclass) 
henry.schwind@navy.smil.mil  (class) 

........................................ (4-07) 

Safety Harness 
Per COMNAVSAFECEN 020239Z JUL 1996, NSN 
4240-00-022-2522 safety harness poses a safety risk 
and is no longer authorized for use.  However, per 
COMNAVSEASYSCOM WASHINGTON DC 
011211Z NOV 06, this safety harness is still being 
used in the fleet.  In FR 4-07, SPMIG 00628 was 
updated to reflect NSN 4240-01-421-0859 vice NSN 
4240-00-022-2522.  
Per COMNAVSEASYSCOM WASHINGTON DC 
291810Z SEP 06, NSN 4240-01-421-0859 (SPMIG 
00628) is being replaced.  The new NSNs are listed 
under SPMIG 00114.  The harness under SPMIG 
00628 is still suitable for use; users are not required to 
replace them.  Maintenance personnel are authorized 
to make pen and ink changes to the MRC when 
replacing SPMIG 00628 with SPMIG 00114.  There 
are two manufacturers listed under SPMIG 00114.  
SPMIGs 00114 A through 00114 C are assigned to 
DBI/SALA safety harnesses and SPMIGs 00114 D 
through 00114 F are assigned to MSA safety harness.  
When using safety harness under SPMIG 00114, it is 
recommended to use safety lanyard of the same 
manufacturer with the safety harness.  SPMIG 00115 
is for DBI/SALA safety lanyard while SPMIG 13124 
is for MSA safety lanyard. 

 
Per COMNAVSEASYSCOM WASH DC 280905Z 
JUN 07, the existing safety lanyard from Mine Safety 
Appliances part number 501195/NSN 4240-00-022-
2521 under SPMIG 00739 is the only lanyard 
authorized for submarines.  The user shall order 
directly from the manufacturer using the part number 
instead of the NSN. 
 
Point of contact for this matter is Rod Ferrer, Code 
401BD, DSN 526-0374, Commercial (619) 556-0374, 
or e-mail rodrigo.ferrer@navy.mil. 

........................................ (4-07) 

NAVSEALOGCEN’s SPMIG 
Application 
The SPMIG.EXE application previously downloaded 
from the NAVSEALOGCEN PMS web site is not 
authorized for use on the Navy Information 
Application Server (NIAPS), or ISNS work stations.  
Installing the SPMIG program overwrites files 
that SKED 3.1 uses to Update PMS Data, FBR 
Manager, etc.   
 
Both SKED 3.1 and PMSViewer have the 
functionality allowing a user to search the SPMIG 
data base.  This database is updated every Force 
Revision when the 3MC updates the PMS Data in 
SKED 3.1 and copies the SPMIG.MDB file into the 
individual installations of PMS Viewer. 

........................................ (2-07) 

TFBR Submission 
All TFBRs must be routed through your chain of 
command as outlined in the NAVSEAINST 4790.8B 
chg 3.  SKED 3.1 is the primary method of 
origination, review and approval, and submission of 
TFBRs from afloat and shore commands with Ships 
Maintenance and Material Management (3M) 
requirements.  All other organizations required to 
submit TFBRs must use the PMS MIS’s TFBR 
development function.  To obtain access to this feature 
please contact rebecca.r.johnson@navy.mil . 
....................................... (2-07) 

 
 
 
PMSViewer Update 
While viewing and/or printing PMS documents with 
earlier versions of the PMSViewer, various formatting 
anomalies may occur.  Please be sure that your 
PMSViewer resource version is 2.0.0.0 or higher (see 
steps below).  If you have installed PMSViewer since 
FR 4-05 or installed the PMSViewer Update, you do 
not need to update PMSViewer. 
 
Determine the Resource version for PMSViewer or 
the version of IE installed on your workstation.   
Perform the following: 
 
1.    Open PMSViewer, select from the Menu bar 

Help>About PMS Resources…  
2.     In the About PMS Resources dialog box, 

Resource version 2.0.0.0 should be listed. 
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3.     Open Internet Explorer, select from the menu bar 

Help>About Internet Explorer. 
4.     The version number is displayed in the Internet 

Explorer dialog box.  
  
If the Resource version is not 2.0.0.0 or you are using 
IE 5.5 or below, uninstall PMSViewer and reinstall 
using the FR 2-08 PMS CD-ROM.  To uninstall and 
reinstall, perform the following: 
 
1. Ensure the PMSViewer application is not 

running.  
2. Click Start and click Control Panel.  
3. Click Add or Remove Programs.  
4. In the list of applications, select PMSViewer and 

click Remove.  
5. Click Yes.  
6. Close Add or Remove Programs and close 

Control Panel.  
7. Click Start and click Run.  
8. Browse to the CD, and double-click Setup.exe.  
9. This will install the newer version of the 

PMSViewer.  
10. Restart the PMSViewer application and the issue 

should be corrected.  
........................................ (4-06) 

PMS CD-ROMs, How Many 
Copies Do You Need?  How 
do I operate them on a 
Ship’s LAN? 
You only need one copy of the FR PMS CD-ROM.  
Most commands have access to a Local Area Network 
(LAN) or Wide Area Network (WAN), and only need 

one copy of the FR PMS CD-ROM.  All users will be 
able to access the data using their current install of 
PMS Viewer.  By copying the PMS CD-ROM Data 
on to the command’s shared drive each user will need 
to follow these simple steps: 
 

1. If not currently installed - Install PMS 
Viewer on the local PC work station. 

2. Open PMSViewer and select from the menu 
bar File > Set Database Location 

3. Browse to the shared drive and directory 
hosting the PMS CD-ROM Data 

4. Expand the Class Type directory.  For 
example:  \\Server\NAVY PMS CD 
Data\GAS.  Double Click on the Class.PMS 
file.  For example:  \\Server\Navy PMS CD           
Data\GAS\GAS.PMS 

5. You must copy the new SPMIG database 
(spmig.mdb) from the latest CD or from the 
Share Drive to your c:\Program 
Files\PMSViewer\data\ directory. 

6. To be able to view the most current 
documents you must copy the contents of the 
Documents directory located on  the CD or 
the Share Drive and place them in c:\Program 
Files\PMSViewer\data\Documents 

........................................ (4-06) 

CD-ROM Installation & 
Operation Troubleshooting 
Guide 
The following explains how to deal with common 
problems that have been reported while using the 
NAVY PMS CD-ROM.  If you cannot find the 

answers to your question or problem, contact 
NAVSEALOGCEN DETs for technical support.  The 
POCs and their phone numbers are contained in the 
Readme file on the CD-ROM. 

System Requirements:  
 Computer with Pentium 166 MHz processor 

or higher.  
 Windows 98, Windows ME, Windows NT 

4.0, Windows 2000, Windows XP. 
 64 MB of RAM. 
 20 MB of hard drive space. 

Note:  
 
1. The preferred Microsoft Internet Explorer version 

is 6.0 or later for the PMSViewer to be installed 
on the machine viewing the PMS cards.  Internet 
Explorer version 5.5 can be used to view the 
documents; however, some printer irregularities 
may occur when printing in landscape mode. 

2. The existing PMSViewer software version 2.0 
will work with FR 2-08 data.  The CD-ROM 
Readme file contains a full description of 
features. 

3. The installation of the PMSViewer requires 
administrative rights.  If you already have 
PMSViewer installed, you do not need to reinstall 
it.  However, you must copy the new SPMIG 
database from the latest CD (spmig.mdb) to your 
c:\Program Files\PMSViewer\data\ directory and 
the current release of 3M documents to 
c:\Program Files\PMSViewer\data\Documents. 
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Installation Tips 
The instructions for installing the PMSViewer 
software are located in the README.RTF file located 
on the Navy PMS CD. 
 
For additional assistance, contact your local LAN 
Administrator or contact the following: 
 
PMS CD-ROM 
For questions regarding problems with installation, 
printing, etc., with the PMS CD-ROM contact one of 
the following: 
 
PAC Activities: Commercial (619) 556-0723,  
DSN 526-0723 or e-mail donald.morrison@navy.mil  
 
LANT Activities: Commercial (757) 967-3404, DSN 
387-3404 or e-mail rebecca.r.johnson@navy.mil 
 
 
For additions, changes or deletions to PMS CD-ROM 
distribution contact one of the following: 
 
PAC Activities: Commercial (619) 556-0624,  
DSN 526-0624 or e-mail maureen.f.evans@navy.mil 
 
LANT Activities: Commercial (757) 967-3405, DSN 
387-3405 or e-mail jon.winoker@navy.mil 
 
 
For additions, changes or deletions to Activity Files, 
contact one of the following: 
 
PAC Activities:  Commercial (619) 556-0624, DSN 
526-0624 or e-mail maureen.f.evans@navy.mil 

 
LANT Activities:  Commercial (757) 967-3418, DSN 
387-3418 or e-mail alice.gusti.ctr@navy.mil 

........................................ (4-07) 


